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Supplemental License Agreement

SUPPLEMENTAL LICENSE AGREEMENT FOR CISCO SYSTEMS 
NETWORK MANAGEMENT SOFTWARE: CISCO NETWORK 
PLANNING SOLUTION 

IMPORTANT-READ CAREFULLY: This Supplemental License Agreement ("SLA") contains additional 
limitations on the license to the Software provided to Customer under the End User License Agreement 
between Customer and Cisco. Capitalized terms used in this SLA and not otherwise defined herein shall 
have the meanings assigned to them in the End User License Agreement. To the extent that there is a 
conflict among any of these terms and conditions applicable to the Software, the terms and conditions 
in this SLA shall take precedence.

By installing, downloading, accessing or otherwise using the Software, Customer agrees to be bound by 
the terms of this SLA. If Customer does not agree to the terms of this SLA, Customer may not install, 
download, or otherwise use the Software. 

ADDITIONAL LICENSE RESTRICTIONS
Restricted Version.  Customer may install and use the Software only within a single specified classful 
IP network, for one concurrent user at a time.  Customer may not de-register any one (1) license for the 
Software more than five (5) times per year without Cisco's prior written approval.  Customers whose 
requirements exceed the restriction of use within a specified IP network must upgrade to the 
non-restricted version of the Software, which allows use up to one hundred (100) additional classful IP 
networks, for one concurrent user at a time.  Usage restrictions are enforced by license registration.  

Non-Restricted Version.  Customer may install and use the Software on Customer's classful IP 
network, for one concurrent user at a time.  Using the non-restricted version, users may utilize the 
Software from the same classful IP network as the license server and up to one hundred (100) additional 
classful IP networks, within the Customer's network management environment.  Usage restrictions are 
enforced by license registration. The deployment of the non-restricted device version is defined by the 
Installation and Use section in this document.
vii
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Supplemental License Agreement
    ADDITIONAL LICENSE RESTRICTIONS
Installation and Use
Cisco Network Planning Solution: May be installed in either Stand-Alone or Floating mode. The 
Stand-Alone Mode allows Software to be used on a single workstation. Users of that workstation can 
operate Software and do not need a network connection.   Floating Mode allows Software to be installed 
on a license server and allows each concurrent user to "check out" a license on an as-needed basis and 
return it automatically when completed. Each concurrent user must be on the same classful IP network 
as the license server.  This license strictly prohibits Customer and any user from utilizing this Software 
for more than a single Customer network management environment. 

Reproduction and Distribution
Customer may not reproduce nor distribute software. 

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
Please refer to the Cisco Systems, Inc. End User License Agreement. 
viii
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Preface

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation DVD
Cisco documentation and additional literature are available in a Documentation DVD package, which 
may have shipped with your product. The Documentation DVD is updated regularly and may be more 
current than printed documentation. The Documentation DVD package is available as a single unit. 

Registered Cisco.com users (Cisco direct customers) can order a Cisco Documentation DVD (product 
number DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace.

Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

Cisco Marketplace:

http://www.cisco.com/go/marketplace/
ix
Installation Guide for Cisco Network Planning Solution

78-17023-01

http://www.cisco.com/univercd/home/home.htm
http://www.cisco.com
http://www.cisco.com/public/countries_languages.shtml
http://www.cisco.com/en/US/partner/ordering/
http://www.cisco.com/go/marketplace/


Preface
    Documentation Feedback
Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you can perform these tasks:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product 
Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
x
Installation Guide for Cisco Network Planning Solution

78-17023-01

http://www.cisco.com/go/marketplace/
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
http://www.cisco.com/en/US/partner/ordering/
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/go/psirt
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html


Preface
    Obtaining Technical Assistance
Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release 
them, and we strive to correct all vulnerabilities quickly. If you think that you might have identified a 
vulnerability in a Cisco product, contact PSIRT:

• Emergencies— security-alert@cisco.com

• Nonemergencies— psirt@cisco.com

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive 
information that you send to Cisco. PSIRT can work from encrypted information that is compatible with 
PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one that has the most recent creation date in this public key server list:

http://pgp.mit.edu:11371/pks/lookup?search=psirt%40cisco.com&op=index&exact=on

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support 
Website by clicking the Tools & Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product 
Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID 
xi
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    Obtaining Technical Assistance
or model name; by tree view; or for certain products, by copying and pasting show command output. 
Search results show an illustration of your product with the serial number label location highlighted. 
Locate the serial number label on your product and record the information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.
xii
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Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
xiii
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C H A P T E R 1

Planning Your Installation

Cisco Network Planning Solution (NPS) is a combination of integrated software applications: 

• A Design and Analysis engine that actually builds a network model, performs analysis and design, 
and provides visualization and reporting. Design and Analysis includes an extensive library of 
technology, protocol, and device models.

• A Virtual Network Data Server that enables the creation of a high fidelity network model based on 
configuration, topology, and traffic information. 

Installation Workflow
The Cisco NPS package contains multiple installation CDs for the software, models, and other 
components of this solution. Product documentation is also installed with the program components. 
Table 1-1 lists the steps in the installation process.

Note Cisco recommends that you do the steps in the order listed in this table.

Table 1-1 Installing Cisco Network Planning Solution: Workflow Description

Description Reference

Step 1 Register your Cisco Solution product Registering Your Cisco Solution Product, page 1-2

Step 2 Determine the host computers Determining Installation Options, page 1-3

Step 3 Determine licensing options Product Licensing, page 1-3

Step 4 Verify system requirements System Requirements for 
Cisco Network Planning Solution, page 2-1

Step 5 Install Design and Analysis Installing Design and Analysis, page 3-1

Step 6 Install Virtual Network Data Server Installing Virtual Network Data Server, page 4-1

Step 7 Add a license (Design and Analysis) Adding a License: Workflow Description, page 5-2

Step 8 Add a license (Virtual Network Data Server) Adding a License: Workflow Description, page 5-2
1-1
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Chapter 1      Planning Your Installation
    Upgrading Licenses
Upgrading Licenses
If you have a Restricted license and want to upgrade it to an Unrestricted license, refer to the “Upgrading 
a License: Workflow Description” section on page 5-3.

Registering Your Cisco Solution Product
Before you can install Cisco NPS, you must register your product with Cisco Systems, Inc. After you 
register your product, Cisco will send you a username, password, and group ID number. You will need 
this information when you install your product licenses (as described in the “Adding a License: 
Workflow Description” section on page 5-2.)

Note By accessing or using the Cisco Systems, Inc. products in this package, you agree that your use of such 
products is governed by the terms and conditions of the Cisco Systems, Inc. Software License and any 
applicable supplemental license agreement.

To review the terms of the Software License before accessing or using the products, you can find a copy 
of the Cisco Software License in the Cisco Information Packet that accompanies the products below or 
online at:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/cetrans.htm

To obtain the license activation credentials, log on to one of the websites listed below and follow the 
registration instructions. The Product Authorization Key (PAK) attached to your Software License 
Claim Certificate is required for the registration process. After registering, retain your Claim Certificate 
for future reference.

Registration Information
Use this URL if you are a registered user of Cisco.com:

http://www.cisco.com/go/license

Use this URL if you are not a registered user of Cisco.com:

http://www.cisco.com/go/license/public

You should receive the activation credentials and additional installation instructions through e-mail 
within one hour of registration. If you experience problems with the registration websites or if you have 
additional questions, contact the Cisco Licensing department through e-mail at licensing@cisco.com, or 
open a service request over the telephone by using one of these numbers:

• Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)

• EMEA: +32 2 704 55 55

• USA: 1 800 553-2447

You can find a complete list of Cisco TAC contacts at this URL:

http://www.cisco.com/techsupport/contacts
1-2
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    Determining Installation Options
Determining Installation Options
Cisco NPS has two component programs:

• Design and Analysis

• Virtual Network Data Server

Before installing the component programs, select the computers where you want to install these 
programs. Each computer must meet the system requirements for the program of interest, as described 
in the System Requirements for Cisco Network Planning Solution chapter.

Note Although you can install Virtual Network Data Server and Design and Analysis on the same computer, 
Cisco strongly recommends that you install these components on separate computers. Doing so will 
achieve the best performance from each component. (Design and Analysis is usually installed on a user 
desktop or laptop, while Virtual Network Data Server is usually installed on a server in the Network 
Operations Center.)

After you complete this step, return to the “Installation Workflow” section on page 1-1.

Product Licensing
Each component program in Cisco NPS—Design and Analysis and Virtual Network Data 
Server—requires a corresponding license to be installed and available to that program. On startup, the 
program contacts a License Server and requests a license; if it does not obtain a license, the program 
does not start. The License Server is a daemon/process that runs on the host where a license is installed; 
it handles license requests from component programs.

After you determine the licensing configuration you want, return to the “Installation Workflow” section 
on page 1-1.

Restricted and Unrestricted Licenses
You can buy either Restricted or Unrestricted versions of the Cisco NPS program licenses. This 
distinction determines the scope of authorized users:

• A Restricted license confines the user of a program to one IP network by default subnet class. This 
means that the licensed program can be used only if the License Server is in the same classful IP 
network. IP network connectivity between the program and server is required.

• An Unrestricted license offers the most flexibility for organizations that operate multiple IP 
networks (as defined by default subnet class). Users can access licenses from within the same 
classful IP network as the License Server as well as from up to 100 additional IP networks. These 
networks must be defined in advance.
1-3
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    Product Licensing
Selecting the License Type
When you install a component program, the installer asks you to specify the licensing mode. The options 
are:

• Floating/Local (“Floating: serve licenses from this computer”)—If you select this option, the 
program will request a license from a License Server running on the local computer.

• Floating/Remote (“Floating: access licenses from remote server”)—If you select this option, the 
program will request a license from a License Server running on a remote computer. (The installer 
also prompts you for the hostname of the remote server.)

Floating mode enables multiple users to share a license for Design and Analysis. The following 
section describes Floating mode in more detail.

• Standalone—This mode is available for Design and Analysis only. If you select this option, the 
installed license is restricted to the local computer and the program can be run on that computer only. 
(In essence, the program acts as its own License Server.) Select this option only if you want to 
restrict the use of Design and Analysis to one computer.

Floating Mode
Floating mode enables multiple users to share a license for Design and Analysis. On startup, the program 
communicates with the License Server automatically and “checks out” a license. When the program 
closes, it returns the license to the License Server. Then the license is available for another Design and 
Analysis user to start the program and check out the license. In Floating mode, the license is not 
“node-locked,” but can “float” to different computers.

Note Multiple users cannot share the same Design and Analysis license concurrently. Multiple concurrent 
Design and Analysis sessions require an equivalent number of program licenses. 

Although the Virtual Network Data Server license server must use Floating mode, its license is not 
shared among multiple users. The Virtual Network Data Server operates automatically, "consuming" its 
license continually. System administrators do not need a license to log in to and operate the system. 
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How Licensing Types and Modes Affect Who Can Use a License
Table 1-2 illustrates how the different license modes and restriction types determine which applications 
can use a specific license.

Licensing Requirements
Note the following requirements:

• You must add the corresponding license as described in the “Adding a License: Workflow 
Description” section on page 5-2. Installing a program and specifying the licensing options does not 
install the license itself. 

• If you specify Floating (remote) licensing for a program, the specified License Server must be 
accessible (via a TCP/IP network) to that program, as described in the “Licensing Requirements” 
section on page 1-5.

• Standalone mode is supported for Design and Analysis only.

• You must use Floating mode for Design and Analysis if Virtual Network Data Server is also running 
on the same host. 

Table 1-2 Licensing Types and Modes

License Mode Used by 
Installed Program

Restriction Type of 
Installed License Client Applications That Can Use the License on the License Server

Applications on the 
Same Host as the 
License Server

Applications in the 
Same Classful IP1 
Network as the License 
Server

1. Classful IP network refers to the classic "A", "B", and "C" IP network classes. For example, if the License Server is installed on a workstation that has a 
class "B" IP network address, then all workstations with the same class "B" address as the License Server are considered to be on the same classful IP 
network as the License Server.

Applications in a 
Different Classful IP 
Network from the 
License Server

Standalone Restricted X

Standalone Unrestricted X

Floating Restricted X X

Floating Unrestricted X X X
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Licensing Scenarios: Examples
This section shows examples of how you can install and configure licenses in your network.

In Table 1-3, all licenses are installed on one host (VNDS_1), which acts as the only License Server in 
the network. The local Virtual Network Data Server program uses Floating/Local mode, while the 
remote programs use Floating/Remote mode. This type of setup is recommended; because there is only 
one License Server, it is easier to manage your licenses and configure programs. 

Table 1-3 Licensing Scenario 1 (Recommended): All Licenses Installed on One Host

Host Name Installed Program Installed Licenses

VNDS_1
(License Server)

Virtual Network Data Server

Licensing options chosen during install:

– license_server1 = (local host)

– license mode2 = Floating/Local

1. Each installed program has a “license_server” preference that specifies where (that is, on which host) the program license is 
installed. This preference is set when the program is installed (as described in the “Selecting the License Type” section on 
page 1-4). On startup, the program reads this preference and contacts the License Server on the specified host.

2. The “license_server” preference determines whether the program is in Local or Remote mode. If you specify Floating (local) 
mode when you install the program, the installer sets the “license_server” preference to (local host) and installs the License 
Server software. If you specify Floating (Remote), the installer prompts you for the name or IP address of the License Server 
host.

Virtual Network Data Server

Design and Analysis

DA_1 Design and Analysis

Licensing options chosen during install:

– license_server = VNDS_1

– license mode = Floating/Remote

—

DA_2 Design and Analysis

Licensing options chosen during install:

– license_server = VNDS_1

– license mode = Floating/Remote

—

DA_3 Design and Analysis

Licensing options chosen during install:

– license_server = VNDS_1

– license mode = Floating/Remote

—
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In Table 1-4, the Design and Analysis program is installed on DA_1 and two other hosts. Each 
installation requests a license from DA_1. (Remember that if only one license is installed on the host, 
only one Design and Analysis session can run at a time.) Virtual Network Data Server is installed on a 
separate host and is configured to obtain a license from a License Server installed on the local host.

Table 1-4 Licensing Scenario 2: Licenses Installed on Multiple Hosts

Host Name Installed Program Installed Licenses

VNDS_1
(License Server)

Virtual Network Data Server

Licensing options chosen during install:

– license_server = (local host)

– license mode = Floating/Local

Virtual Network Data Server

DA_1
(License Server)

Design and Analysis

Licensing options chosen during install:

– license_server = (local host)

– license mode = Floating/Local

Design and Analysis

DA_2 Design and Analysis

Licensing options chosen during install:

– license_server = DA_1

– license mode = Floating/Remote

—

DA_3 Design and Analysis

Licensing options chosen during install:

– license_server = DA_1

– license mode = Floating/Remote

—
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System Requirements for 
Cisco Network Planning Solution 

This chapter describes the system requirements for the individual components in Cisco NPS. Cisco 
recommends that, before you start to install Cisco NPS, you verify that your computer hardware and 
software meet the requirements outlined in this chapter. 

After you complete this step, return to the “Installation Workflow” section on page 1-1.

Design and Analysis: System Requirements

Supported Platforms

Table 2-1 Supported Platforms for Design and Analysis

Vendor1 

1. Design and Analysis is supported on the English language version of each operating system.

OS Processor

Sun Microsystems Solaris 8, 9 UltraSPARC or later processor (such as 
UltraSPARC II or UltraSPARC III)

Microsoft Windows NT 4.0
Windows 2000 Professional
Windows XP Professional 
Windows 2000 Server 
Windows Server 2003 

Intel Pentium 3, 4, or compatible (1.5 GHz or 
higher)
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Required System Patches

Obtaining the Solaris 8 Patch Cluster

To obtain the Solaris 8 patch cluster, perform the following procedure:

Step 1 Visit http://sunsolve.sun.com/patches.

Step 2 Follow the link Recommended Patch Clusters from the right-hand side of the page.

Step 3 Download the Solaris 8 patch from the listing of Recommended Solaris Patch Clusters, J2SE and Java 
Enterprise System Clusters.

System Configuration

Table 2-2 Required System Patches for Design and Analysis

Vendor OS Patch Number/Name

Sun Microsystems Solaris 8 Solaris 8 Recommended Patch 
Cluster1 

Solaris 8 Patch 111308-042 

1. To obtain the Solaris 8 Patch Cluster, follow the instructions in Obtaining the Solaris 8 Patch Cluster.

2. Patch 111308-04 is required only if using the Parallel Discrete-Event Simulation Kernel.

Microsoft Windows NT 4.0 Service Pack 3, 5, or 6a (Service 
Packs 4 and 6 are not supported)

Windows 2000 Professional Service Packs 1, 2, and 4 are 
supported, but not required.

Windows XP Professional Service Pack 1 is required; 
Service Pack 2 is supported, but 
not required.

Table 2-3 System Configuration for Design and Analysis

RAM Minimum 256 MB, recommended 512 MB – 2 GB1

1. Recommended system configuration varies based on scale and complexity of analysis being performed. Please contact your 
Cisco representative to determine recommendations for your specific Design and Analysis deployment.

System File Space 760MB (Windows), 1.1GB (Solaris)

Working File Space 100 MB or more for temporary and log files

Display Resolution: 1024x768 minimum
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Other Requirements

External Software Compatibility

Import of Network Topology

Device Configuration Import is an integrated feature of Design and Analysis that enables a simple 
network model to be created by importing device configuration files for some vendor devices. It is 
generally used to support test or evaluation scenarios where the Virtual Network Data Server is not 
available. The requirements for external software compatibility discussed here apply to Device 
Configuration Import, and not necessarily the Virtual Network Data Server.

Device Configuration Import is available for the following devices: Cisco IOS versions 10.0 and above, 
Cisco CatOS version 4.1 and above, Cisco PIX 6.0 and above, and Juniper JunOS 4.0 and above.

Import of Network Traffic

Design and Analysis includes an integrated feature to import traffic information directly into a network 
model exclusive of the Virtual Network Data Server. These requirements for external software 
compatibility apply only to this feature.

Table 2-4 Other Requirements for Design and Analysis

Supporting Software TCP/IP networking software

Special Requirements (UNIX) On UNIX installations, the license file must be stored in either the /opt 
or /var/adm directory. The directory that is chosen must be located on 
a local hard drive or partition, must not be a symlink, and must not be a 
network mounted partition.

Browser Netscape 7.0 or higher, Internet Explorer 5.0 or higher, or a compatible 
browser that supports style sheets.

Table 2-5 Traffic Import Formats Supported by Design and Analysis

Product Version Supported Data Type

HP OpenView Performance Insight 4.6 Import of link loads

InfoVista 2.2 Import of link loads

MRTG 2.9.25 or higher Import of link loads

Network General Distributed Sniffer and Sniffer Pro 3.5 and higher Import of traffic flows

cflowd 2.1 Import of traffic flows

Network General Sniffer Analyzer 5.50 Traffic data may be imported from Sniffer 
Analyzer in the following formats:

• Sniffer Analyzer Packet Trace CSV

• Sniffer Analyzer Expert Data CSV

Concord Network Health and eHealth 4.8 and 5.0.2 Import of link loads
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Virtual Network Data Server: System Requirements

Supported Platforms

Required System Patches

NetScout nGenius 1.3, 1.4, and 2.0 Import of traffic flows

Import of flow data from Foundry devices and 
NetFlow data from Cisco devices is supported if 
this information is gathered by NetScout probes 
and stored in the nGenius database.

If you are using nGenius 1.4, you may need to 
download the OPNET/nGenius Patch. Data may 
be imported by Cisco NPS running on Windows 
NT 4.0/2000/XP and Sun Solaris.

Cisco NetFlow Collector 3.0 Import of traffic flows

Fluke Networks OptiView Console 6.5.1 Import of traffic flows. Only ATM OC3 probe 
supported.

Table 2-6 Supported Platforms for Virtual Network Data Server

Vendor1 

1. Virtual Network Data Server is supported on the English-language version of Windows.

Series

Microsoft Windows 2000 Server

Windows 2000 Professional

Windows XP Professional

Windows Server 2003

Table 2-7 Required System Patches for Virtual Network Data Server

Vendor OS Patch Number/Name

Microsoft Windows 2000 Server Service Pack 2 minimum

Windows 2000 Professional Service Pack 2 minimum

Windows XP Professional N/A

Windows Server 2003 N/A

Table 2-5 Traffic Import Formats Supported by Design and Analysis (continued)

Product Version Supported Data Type
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To determine the service pack installed on your Windows system, run winver.exe:

Step 1 Select Start > Run from the bottom left of your Windows screen.

Step 2 Type in the command winver and click OK. The About Windows window appears and shows the version 
and service pack level installed.

Windows System Configuration

Note Remote access to the Virtual Network Data Server console window is unavailable under Windows 2000 
Server when run under Windows Terminal Services. Cisco recommends running Virtual Network Data 
Server under Windows Server 2003 if it is to be deployed on Windows Terminal Services. Otherwise, 
users on Windows 2000 Server will need physical access to the server’s console for access to the Virtual 
Network Data Server user interface.

Note Virtual Network Data Server does not operate on machines with the Intel Itanium processor. To check 
the processor used by your Windows computer, right-click on the My Computer desktop icon and 
choose Properties.

Table 2-8 Windows System Configuration Requirements for Virtual Network Data Server

Processor1 

1. A dual-processor configuration is recommended if Virtual Network Data Server and the back-end Oracle database are to 
reside on the same platform.

RAM2 

2. Virtual Network Data Server performance will improve with more available memory as network size increases.

Free Disk Space FSB3

3. Front-Side Bus (FSB) speed affects the speed of data transfer to and from the Virtual Network Data Server database; faster 
bus speeds will improve Virtual Network Data Server performance.

Minimum Intel Pentium 4, 2.4 GHz 2 GB 20 GB 800 MHz

Intel Xeon, 2.4 GHz 2 GB 20 GB 533 MHz

Recommended Intel Pentium 4, 3+ GHz 3 GB 80 GB 800 MHz

Intel Xeon, 3+ GHz 3 GB 80 GB 800 MHz
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Other Requirements

Table 2-9 Other Requirements for Virtual Network Data Server

Software Platform  Supported Version 
Required Database 
Character Set1

1. The supported national character set is: AL16UTF16. For international customers: The Virtual Network Data Server 1.0 
product may not operate correctly when used with Oracle databases that have been configured with international, or Unicode 
(AL32UTF8), database character sets."

Oracle 
Database2

2. Contact Oracle Corporation for information about Oracle 9i system requirements. 

Windows • Oracle 9i Release 2 (version 9.2.0.1 or 
higher)

• Oracle 9i Application Server (AS) 
TopLink patched to Release 9.0.3.5 

WE8MSWIN1252
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Installing Design and Analysis

These installation instructions apply to Design and Analysis. After you install this package, return to the 
“Planning Your Installation” section on page 1-1.

Installing Design and Analysis on Windows
Use the following procedure to install Design and Analysis from the product CDs.

Installing Design and Analysis on Windows

Step 1 Log in as Administrator before inserting a CD.

Step 2 Insert the Design and Analysis software CD into your CD-ROM drive. 

The installation program should start automatically. If it does not start, double-click on the icon that 
represents the CD-ROM and click on the setup.exe icon.

Note If you are installing on Windows XP, you might see an error window that reads, “OPNET 
<product_name> has encountered a problem and needs to close.” This error occurs because the 
installer caused an existing License Server process (op_license_server.exe) to terminate 
abnormally. This is known issue; simply click Don’t Send and proceed with the installation.

You will be prompted for a directory in which to install your software (typically 
C:\Program Files\Cisco\CiscoNPS1.0).

Step 3 When the software installer prompts you to specify the type of licensing system to install, the following 
might help you decide:

• Standalone is recommended if you are the only Design and Analysis user. 

• Floating: access licenses from a remote server is the correct choice if you already have the Design 
and Analysis License Server running on a remote machine and you want this installation to get its 
licenses from that machine.

• Floating: serve licenses from this computer is the correct choice if the current machine will be the 
License Server. 

For more information about these options, see the “Product Licensing” section on page 1-3.

Step 4 Insert the Design and Analysis models CD and run the installer.

Step 5 Insert the Design and Analysis documentation CD and run the installer.
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Note Installing the Design and Analysis package does not install the license for this program. Before 
you can run the program, you must add the license as described in the “Adding and Upgrading 
Licenses” chapter in this guide.

Installing Design and Analysis on Solaris

Warning Cisco NPS 1.0 requires specific Solaris system patches. 
For a list of required patches, see Required System Patches, page 2-2.

Use the following procedure to install Design and Analysis from the product CDs.

Installing Design and Analysis on Solaris

Step 1 Log in as root.

Step 2 Insert the Design and Analysis software CD into your CD-ROM drive. 

a. Move to the unix directory on the CD, which is /cdrom/cdrom0/unix. 

b. Enter the command ./op_install.

c. When you are prompted to specify the type of licensing system to install, the following might help 
you decide:

– Standalone is recommended if you are the only Design and Analysis user.

– Floating -- access licenses from a remote server is the correct choice if you already have a 
License Server running on a remote machine and you want this installation to get its licenses 
from that machine. 

– Floating -- serve licenses from this computer is the correct choice if the current machine will be 
the License Server. 

For more information about these options, see the “Product Licensing” section on page 1-3.

d. At the end of the software installation script, you will see the instruction “To complete the 
installation process, follow these steps.” Note this information for use in configuring user accounts.

e. When you see the prompt “End of installation script”, change directories to /tmp to allow the CD 
to be ejected.

f. Eject the CD with the eject command.

Step 3 Insert the Design and Analysis models CD and run the installer.

Step 4 Insert the Design and Analysis documentation CD and run the installer.
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Note Installing the Design and Analysis package does not install the license for this program. Before 
you can run the program, you must add the license as described in the “Adding and Upgrading 
Licenses” chapter in this guide.

Preparing User Accounts
Instructions for modifying the path setting of user accounts are displayed by the installation script (step 
d in “Installing Design and Analysis on Solaris” procedure on page 3-2).
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Installing Virtual Network Data Server

These installation instructions apply to Virtual Network Data Server, which is supported on Windows 
only. After you complete this procedure, return to the “Installation Workflow” section on page 1-1.

System Requirements 
The host system for Virtual Network Data Server must meet minimum requirements. These requirements 
are documented in the “Virtual Network Data Server: System Requirements” section on page 2-4.

If the host system does not meet minimum requirements, do not install Virtual Network Data Server. If 
the host system does not have an Oracle database or an Oracle client installation, but meets all other 
requirements, install Oracle before installing Virtual Network Data Server. The following section 
describes the installation procedures you need to follow for specific installation scenarios. 

Installation Workflow 
This chapter covers the various installation scenarios you may encounter with Virtual Network Data 
Server. The procedures you must follow depend upon whether this is an initial Virtual Network Data 
Server installation or an upgrade. The procedures to follow also depend upon whether Virtual Network 
Data Server uses a local or a remote database. 

Select the installation workflow appropriate for your circumstances. Follow the procedures in your 
workflow to install Virtual Network Data Server. 

• Workflow 1: Initial Installation (Local Oracle Database), page 4-2

• Workflow 2: Initial Installation (Remote Oracle Database), page 4-2

• Workflow 3: Initial Installation (Oracle Already Installed), page 4-3

Note You can install and run one instance only of Virtual Network Data Server on any one computer. 
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Workflow 1: Initial Installation (Local Oracle Database)
If you are installing Virtual Network Data Server for the first time and will install Oracle on the same 
host PC, follow this workflow.

Installing Virtual Network Data Server (with Oracle Database on Local Host)—Workflow Description

Step 1 Install the Oracle database on the host PC for Virtual Network Data Server. 

See the “Installing the Oracle 9i Database” procedure on page A-1.

Step 2 Collect Oracle database access information.

See the “Collecting Oracle Database Access Information” procedure on page A-5.

Step 3 Install Oracle TopLink.

See the “Installing Oracle TopLink” procedure on page A-6.

Note You must complete the previous steps before you install Virtual Network Data Server.

Step 4 Install Virtual Network Data Server.

See the “Installing Virtual Network Data Server” procedure on page 4-3.

Step 5 Configure the Oracle database. 

See the “Configuring the Oracle Database” procedure on page A-7.

Step 6 Verify the Oracle configuration. 

See the “Verifying the Oracle Configuration” procedure on page A-10.

Step 7 Verify the Virtual Network Data Server installation.

See the “Verifying the Virtual Network Data Server Installation” procedure on page 4-8.

Workflow 2: Initial Installation (Remote Oracle Database)
If you are installing Virtual Network Data Server for the first time and will install Oracle on a different 
host PC, follow this workflow.

Installing Virtual Network Data Server (with Oracle Database on Remote Host)—Workflow Description

Step 1 Install the Oracle 9i database on the database host PC.

See the “Installing the Oracle 9i Database” procedure on page A-1.

Step 2 Install the Oracle 9i client on the Virtual Network Data Server PC.

See the “Installing the Oracle 9i Client” procedure on page A-3.

Step 3 Collect Oracle database access information.

See the “Collecting Oracle Database Access Information” procedure on page A-5. 
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Note You must complete the previous steps before you install Virtual Network Data Server.

Step 4 Install Virtual Network Data Server.

See the “Installing Virtual Network Data Server” procedure on page 4-3.

Step 5 Configure the Oracle Database on the database host PC.

See the “Configuring the Oracle Database” procedure on page A-7. 

Step 6 Verify the Oracle configuration on the database host PC.

See the “Verifying the Oracle Configuration” procedure on page A-10.

Step 7 Verify the Virtual Network Data Server Installation.

See the “Verifying the Virtual Network Data Server Installation” procedure on page 4-8.

Workflow 3: Initial Installation (Oracle Already Installed)
If you are upgrading a previous Virtual Network Data Server installation, follow this workflow.

Upgrading from a Previous Virtual Network Data Server Installation—Workflow Description

Step 1 Collect Oracle database access information.

See the “Collecting Oracle Database Access Information” procedure on page A-5.

Step 2 Install Virtual Network Data Server.

See the “Installing Virtual Network Data Server” procedure on page 4-3.

Step 3 Configure the Oracle database on the host PC.

See the “Configuring the Oracle Database” procedure on page A-7.

Step 4 Verify the Oracle configuration on the database host PC.

See the “Verifying the Oracle Configuration” procedure on page A-10.

Step 5 Verify the Virtual Network Data Server installation.

See the “Verifying the Virtual Network Data Server Installation” procedure on page 4-8.

Installing Virtual Network Data Server 
You are now ready to install Virtual Network Data Server, using the following procedure.

Note You can install and run one instance only of Virtual Network Data Server on any one computer. 
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Installing Virtual Network Data Server

Step 1 Log into the host PC as Administrator or as a user with full administrative privileges. If you are not 
logged in with the proper privileges, log off and then log on with an appropriate account. 

Step 2 Insert the Virtual Network Data Server installation CD. 

If Virtual Network Data Server is already installed on the host PC and you are upgrading to a new release, 
perform the following steps before continuing: 

a. Stop Virtual Network Data Server operation by selecting Services > Stop Services from the Virtual 
Network Data Server Control Panel. 

b. Exit Virtual Network Data Server by selecting File > Exit from the Control Panel menu bar. 

c. Use a License Manager to see if your Virtual Network Data Server license is still held. If the license 
is still held by Virtual Network Data Server, use the License Manager to revoke the license. 

Step 3 Insert the Virtual Network Data Server installation CD into the CD-ROM drive of the host PC. If the 
installer does not start automatically, use Start > Run to execute the setup_Windows.exe program on 
the CD. 

The installer displays an Introduction panel. 

Step 4 Click Next. 

If an existing Virtual Network Data Server installation is detected, a Notice window appears to remind 
you to stop services and exit Virtual Network Data Server. Click Yes to continue or No to cancel the 
installation. 

Step 5 Determine your Oracle installation scenario and follow instructions within that scenario as described in 
Table 4-1. 
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Note Virtual Network Data Server can operate with either a local or remote Oracle database. If a local 
database is present, you have the option of using this database. You can also choose to use a 
remote database. In either case, the installer displays a panel which requests database access 
information. If a local database is not found, but an Oracle client installation is detected, the 
installer displays a panel requesting access information about the remote database. While the 
Oracle database may be installed on a remote system, the Virtual Network Data Server and 
Oracle database cannot be separated by a WAN. This means that they must be co-located and 
connected via a high speed local link. This connection should be unimpeded by an intervening 
firewall.

Step 6 Specify local database access information. 

Note Select a user name that is dedicated for use by the Virtual Network Data Server service.

The installer prompts you for the following database access information: 

• Local Database TNS Service Name

Table 4-1 Oracle Installation Scenarios

Scenario Oracle Installation Instructions

1 • An Oracle installation is not 
present on the host PC.

• A message box indicates that 
Oracle cannot be found.

• Abort installation. Click OK to cancel the 
installation.

• Install Oracle on the host PC before attempting to 
install Virtual Network Data Server.

2 • Oracle database installation is 
present on host PC.

• If more than one Oracle 
installation is found on the 
host PC, the installer asks 
which Oracle you wish to use. 
Select the radio button for the 
correct Oracle installation and 
click Next.

• An installer panel appears and asks if you want 
Virtual Network Data Server to use the local 
database. 

– Select No to use a remote database, then 
continue with Step 8 of the “Installing Virtual 
Network Data Server” procedure on page 4-3.

– Select Yes to use the local database, then 
continue with Step 6 of the “Installing Virtual 
Network Data Server” procedure on page 4-3.

3 • Oracle client installation is 
present on the host PC.

• If more than one Oracle 
installation is found on the 
host PC, the installer asks you 
which Oracle you wish to use. 
Select the radio button for the 
correct Oracle installation and 
click Next.

• An installer panel appears stating that a local 
Oracle client is detected1.

• If the Oracle installation is a client, select the 
Client radio button. Click OK, then continue with 
Step 8 of the “Installing Virtual Network Data 
Server” procedure on page 4-3.

• If the Oracle installation is really a local database 
server, select the Server radio button. Enter the 
Database SID from Table 1. Click OK and 
continue with Step 6 of the “Installing Virtual 
Network Data Server” procedure on page 4-3.

1.Depending upon how Oracle is installed and databases are created, what appears 
to be a client installation might really be a server.
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• Local Database User Name

• Local Database Password

• Confirm Password

Step 7 Fill in each field with the information collected in Table A-1 on page A-6, click Next, and then jump to 
Step 10. 

Step 8 Specify remote database access information. The installer prompts you for the following database access 
information: 

• Remote Database TNS Service Name

• Remote Database SID

• Remote Database Hostname

• Remote Oracle Home Directory

• Remote Oracle Oradata Parent Directory

Step 9 Fill in each field with the information collected in Table A-1 on page A-6, and then click Next. 

Note Select a user name that is dedicated for use by the Virtual Network Data Server service.

The installer prompts you for the following remote database access information: 

• Remote Database User Name

• Remote Database Password

• Confirm Password

Step 10 Fill in each field with the information collected in Table A-1 on page A-6 and click Next. The installer 
prompts you for the location of Oracle Toplink files required by Virtual Network Data Server. 

Note Note: Version 9.0.3.5 of Oracle Toplink is required. 

a. If you have Toplink installed to the default path within your existing Oracle installation, the default 
path shown in this panel is the correct path. Locate the path on your system that contains the 
following Toplink files: tl_core.jar, tl_tools.jar, and tl_x.jar. 

b. Click Choose and browse to the directory of the required Oracle Toplink files. Click Select to 
complete your choice. 

Step 11 Click Next. If the required files are not found at the selected path, an error dialog appears. Click one of 
the following:

• OK to try again to select a path. 

• Cancel to cancel the installation.

Step 12 After selecting the path to the Toplink files required by Virtual Network Data Server, choose the type of 
licensing you want to use. 

a. The installer displays a panel with some general notes about licensing and licensing information that 
is specific to this release. Read the panel notes before you continue with the installation. Click one 
of the following:

– Yes to continue with the installation, 

– No to cancel the installation, or 
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– Previous to back up to the previous panel. 

b. The installer prompts you for the type of licensing to use. The panel displayed depends upon the 
licensing scenario detected on your system. Each panel provides a choice between local and remote 
licensing. 

If a local License Server is not detected on your system or one is detected as part of a previous 
Virtual Network Data Server installation, select one of the following choices: 

– Access licenses from a remote server 

– Serve licenses from a License Server on this computer 

Note Selecting the local option results in a License Server being installed as a part of the Virtual 
Network Data Server installation. This License Server is the same program installed with 
other Cisco NPS 1.0 programs such as Design and Analysis. 

If a local License Server is detected on your system as part of an existing Cisco NPS installation, 
select one of the following choices: 

– Access licenses from a remote server 

– Serve licenses from a License Server on this computer 

Note Selecting the local option configures Virtual Network Data Server to use the local License 
Server that is part of an existing Cisco NPS installation. No License Server is installed with 
Virtual Network Data Server. 

Step 13 Click Next. 

If you selected local licensing, continue with Step 14. 

If you selected licensing from a remote server, the installer prompts you for the server name and port. 

a. Enter the hostname of the remote License Server in the Server field. 

b. Enter the port (either port_a, port_b, or port_c) used by the remote License Server in the Port field. 

Note Write down the license settings you have chosen for future reference. 

The installer prompts you for an installation path. 

Note If you are installing on Windows XP, you might see an error window that reads, “OPNET 
<product_name> has encountered a problem and needs to close.” This error occurs because the 
installer caused an existing License Server process (op_license_server.exe) to terminate 
abnormally. This is known issue; simply click Don’t Send and proceed with the installation.

Step 14 Type an installation path in the panel’s Path field or use the file browser to select an installation path. 
The path you choose cannot contain embedded spaces. 

Note The path you enter is the parent directory for the installation. The installer appends 
\VNEServer\3.0.1_<build_number> to the path. 
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Step 15 Click Next. 

The installer prompts you for the path to use for the Virtual Network Data Server temp directory. 

Step 16 Type a temp directory path in the panel’s path field or use the file browser to select a path. The path you 
choose cannot contain embedded spaces.

Note The temp directory holds temporary working files for the product. The path you specify is the 
full path to this directory. 

Step 17 Click Next. 

The installer prompts you for the path to use for the Virtual Network Data Server archive directory. 

Step 18 Type an archive directory path in the panel’s Path field or use the file browser to select a path. The path 
you choose cannot contain embedded spaces.

Note The archive directory holds collected device configuration files that have been archived by the 
product. The path you specify is the full path to this directory. 

Step 19 Click Next. An Installation Progress panel shows status messages as Virtual Network Data Server 
installation progresses. Installation normally finishes in several minutes. When the installation is 
finished, an Install Complete panel appears. 

Note The installer checks the version of the Oracle Toplink files that you chose in Step 10. If the 
wrong version files were selected, an error dialog box appears. Click OK to continue. Before 
operating Virtual Network Data Server, you must locate the correct version of the required 
Toplink files and copy them to the <install dir>\ext directory.

Step 20 Click Done to exit the installer. 

Note Before you can use Virtual Network Data Server, you must first install a Virtual Network Data Server 
license as described in the “Adding a License: Workflow Description” section on page 5-2 in this guide.

For additional information about licensing, refer to the following sections of the product documentation:

• Virtual Network Data Server User Guide > Administration chapter > Product Licensing section

• Administrator Guide (in Design and Analysis documentation) > License Manager

• Administrator Guide (in Design and Analysis documentation) > License Server

Verifying the Virtual Network Data Server Installation 
After Oracle installation is complete, configured, and verified, verify that Virtual Network Data Server 
is installed correctly. 
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Verifying the Virtual Network Data Server Installation

Step 1 Open the Virtual Network Data Server Control Panel from the Program Group shortcut as follows: 

Start > Programs > Cisco Network Planning Solution 1.0 > Virtual Network Data Server

Within a minute, the Virtual Network Data Server Control Panel appears. 

Step 2 Start Virtual Network Data Server services from the Control Panel by clicking the Start Services button 
on the tool bar. 

A progress dialog appears, and—within a few minutes—service start-up completes. 

Step 3 Stop Virtual Network Data Server services from the Control Panel by clicking the Stop Services button 
on the tool bar.

A progress dialog appears, and—within a few minutes—services stop. 

Step 4 Click the Exit button on the Control Panel tool bar to exit from Virtual Network Data Server. 

Note If the Control Panel fails to open, services fail to start or stop, or error dialog boxes appear, there 
is a problem with the installation. Contact Cisco Technical Support for assistance.
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Adding and Upgrading Licenses

To start a component program (such as Design and Analysis or Virtual Network Data Server), you must 
have a valid license for that program installed on the local or a remote computer. You must add a license 
for each component program included with Cisco NPS:

• Design and Analysis

• Virtual Network Data Server

This chapter describes the following operations:

• Adding a License: Workflow Description, page 5-2—Perform this workflow if you have purchased 
a Cisco Solution package and want to add the new licenses.

• Upgrading a License: Workflow Description, page 5-3—Perform this workflow if you have already 
added a Restricted license and want to upgrade it to an Unrestricted license.

Note You must add a license on a host where the component program can access that license on startup. You 
can choose to select the license on the same computer as the program or on a remote host that is 
accessible to the program. For more information about licensing options, see the “Product Licensing” 
section on page 1-3.

Using the License Manager
You can see which licenses and License Servers are installed on your network by using the License 
Manager. You can also perform license operations from the License Manager using the following 
procedure.

Step 1 Log on to a computer that has Design and Analysis installed.

Step 2 Choose Start > Programs > Cisco Network Planning Solution 1.0 > License Manager. The License 
Manager window appears.

Note In some cases, the License Manager might show some child windows prompting you for 
additional information such as which product modules to use. You do not need to specify these 
options to use the License Manager; generally you can click OK to accept the default settings 
and close the child window.
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Step 3 In the License Manager, select the license(s) or License Server you want to act on, then click on the 
correct operation button on the right.

License Names
You might notice, when viewing licenses in the License Manager, that the license name might differ 
from the Cisco component name. The following table shows the component products and the license 
names that might appear for each component.

Adding a License: Workflow Description
Table 5-2 shows the workflow for adding your licenses.

Obtaining a Username and Password
To add a license, you must have a valid username, password, and group ID. To obtain this information, 
you must register your Cisco NPS product with Cisco Systems, Inc. Instructions for doing this are listed 
on the Software License Claim Certificate that is included in your product installation package. For more 
information, see the “Registering Your Cisco Solution Product” section on page 1-2.

After your registration is confirmed, Cisco will send you an email with a username, password, and Group 
ID number. You will need this information when you add the component licenses as described in the 
following sections.

Table 5-1 Cisco Product Names and License Names

Cisco Program License Name

Design and Analysis IT Guru

Virtual Network Data Server VNE Server

Table 5-2 Adding a License: Workflow Description

Description Reference

Step 1 Obtain a username and password (you only need to do this 
once per bundle)

Obtaining a Username and Password, page 5-2

Step 2 Add program license(s) using one of the following 
methods for each license:

• Express method Adding a License (Express Method), page 5-4

• Browser method (if Express method does not work) Adding a License (Browser Method), page 5-5

• Contact Cisco Technical Support (if Express and 
Browser methods do not work)

Technical Support for Licensing Operations, page 5-8

Note You must repeat the Add License procedure for every computer on which you want to add a license. For 
example, suppose you want to add the Design and Analysis and Virtual Network Data Server licenses two 
separate computers. In this case, you must do the add-license operation twice—once for each computer
5-2
Installation Guide for Cisco Network Planning Solution

78-17023-01



Chapter 5      Adding and Upgrading Licenses
    Upgrading a License: Workflow Description
After you obtain a username and password, you can add your licenses as described in the “Adding a 
Component License (Express Method)” procedure on page 5-4 or the “Adding a Component License 
(Browser Method)” procedure on page 5-5.

Upgrading a License: Workflow Description
Table 5-3 shows the workflow for upgrading your licenses. For information about different grades of 
licenses, see the “Licensing Requirements” section on page 1-5.

Obtaining an Upgrade Authorization from Cisco Systems, Inc.
Before you can upgrade a Cisco Solution license, you must obtain an authorization from Cisco Systems, 
Inc. To obtain an authorization, do the following:

Step 1 Go to the following URL:

http://www.opnet.com/support/cisco_qsp.html

Step 2 Follow the My PAKS link to see the Product Authorization Keys you have added already. Note the PAK 
of the product that you want to upgrade from Restricted to Unrestricted.

Step 3 Go to one of the URLs listed in the“Registration Information” section on page 1-2. 

Step 4 Follow the instructions on the Cisco licensing page. You must submit the Product Authorization Key for 
both the new license and the original license that you want to upgrade. 

Table 5-3 Upgrading a License: Workflow Description

Description Reference

Step 1 Obtain an Upgrade authorization from Cisco Systems, Inc. Obtaining an Upgrade Authorization from Cisco 
Systems, Inc., page 5-3

Step 2 Deregister the original (Restricted) license using one of the 
following methods:

• Express method Deregistering a License (Express Method), page 5-6

• Browser method (if Express method does not work) Deregistering a License (Browser Method), page 5-7

• Contact Cisco Technical Support (if Express and 
Browser methods do not work)

Technical Support for Licensing Operations, page 5-8

Step 3 Add the upgraded (Unrestricted) version of the original 
license using one of the following methods:

• Express method Adding a License (Express Method), page 5-4

• Browser method Adding a License (Browser Method), page 5-5

• Contact Cisco Technical Support (if Express and 
Browser methods do not work)

Technical Support for Licensing Operations, page 5-8

Note You must perform both procedures—that is, deregister the Restricted license and add the Unrestricted 
license—before you can use Unrestricted licensing mode. Also, keep in mind that after you deregister your 
current (Restricted) license, you will be unable to use the software until you register the updated 
(Unrestricted) license.
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After you submit the requested information, Cisco Systems will email you an authorization to proceed 
with the upgrade (go to Step 2 of Upgrading a License: Workflow Description, page 5-3). 

License Operations

Adding a License (Express Method)
The following procedure is the quickest and easiest way to add a license. This method requires that your 
computer be able to communicate directly with the Cisco Solutions license-registration server over the 
Internet, either directly or using a proxy server.

Note You must perform an add-license procedure (using Express, Browser, or an alternative method) for 
every computer to which you want to add a license. For example, suppose you want to add the Design 
and Analysis and Virtual Network Data Server licenses to two separate computers. In this case, you must 
go to each computer separately and add the desired license.

Note The Express method can fail due to firewall restrictions, socket or proxy errors, or transaction time-outs. 
If you cannot add the license using this method, try the Browser method (as described in Adding a 
License (Browser Method), page 5-5).

Adding a Component License (Express Method)

Step 1 Start the License Manager: Go to the Windows Start menu and choose Start > Programs > 
Cisco Network Planning Solution 1.0 > License Manager. 

Step 2 In the License Manager, click on the green dot that represents the License Server on the computer where 
you want to add the license. (The License Server computer might not be the same as your local 
computer.) 

Click on the Add License button on the right side of the box.

Step 3 When prompted to select the transaction method, click Express. This method is easiest and fastest.

Step 4 Enter the Username, Password, and Group ID that you received when you registered your product with 
Cisco Systems, Inc. (as described in the “Obtaining a Username and Password” section on page 5-2).

Step 5 If the computer uses a proxy server, click on Specify Proxy button and fill in the information.

Step 6 The next screen shows a list of available licenses. To select one license, click on it. To select multiple 
licenses, control-click or drag on the licenses. 

Note Select only the licenses you want to add to the computer of the License Server you have selected. 
(If you also want to add other licenses to a different computer, you must repeat this procedure 
for that computer.)
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Step 7 After you select the licenses you want to add, click on the Add License button at the bottom. A progress 
window might appear while the license is added to your computer. A window should then appear and 
say that the license operation succeeded. 

Step 8 When the operation is complete, the Select Product Modules box might appear. This allows you to select 
the modules you want to use. (In most cases, you should select all available modules.)

Step 9 To start using the program, exit the License Manager and start the program.

Adding a License (Browser Method)
Before using the Browser method, try the Express method. With the Express method, there is no need to 
exchange codes and you can add many licenses to your computer in one operation. Use this procedure 
if the Express method fails or you prefer to use the Browser method.

Note You must perform a license-add procedure (using Express, Browser, or an alternative method) for every 
computer to which you want to add a license. For example, suppose you want to add the Design and 
Analysis and Virtual Network Data Server licenses to two separate computers. In this case, you must go 
to each computer separately and add the desired licenses.

Note If you still cannot add your licenses using this method, see the “Technical Support for Licensing 
Operations” section on page 5-8.

Adding a Component License (Browser Method)

Step 1 Start the License Manager: Go to the Windows Start menu and choose Start > Programs > 
Cisco Network Planning Solution 1.0 > License Manager. 

Step 2 License Manager: Click on the green dot that represents the License Server on the computer where you 
want to add the license. (The License Server computer might not be the same as your local computer.) 

Click Add License on the right side of the window.

Step 3 License Manager: When prompted, click Browser. The following events should now occur:

• The License Manager launches your Web browser and points it to the OPNET Quick Support Page 
for Cisco Solutions.

• The License Manager shows a transaction code and a hostname.

Step 4 Web browser: Enter the Username and Password that you received when you registered your product 
with Cisco Systems, Inc. (as described in the “Obtaining a Username and Password” section on 
page 5-2).

If your browser fails to launch, start it manually and navigate to the following URL:

http://www.opnet.com/support/cisco_qsp.html

Then follow the License Registration link in the browser window.

Step 5 Web browser: Click Perform license operations, then select Add License (add_permits) and click 
Next. Back in the License Manager, a dialog box containing a Transaction Code and Hostname field 
should appear.
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Step 6 Web browser: Copy the Transaction Code and Hostname from the License Manager into the 
corresponding fields in the browser. You can either copy/paste the text or type it manually. 

Note Make sure there are no extra spaces before or after the code or hostname.

Step 7 Web browser: Click Next. 

Step 8 Web browser: When the Select the starting license number page appears, select the lowest license ID 
that you want to add to your computer. If you want to add only one license, select that license.

Step 9 Web browser: When the Select the ending license number page appears, select the highest license ID that 
you want to add to your computer. If you want to add only one license, select that license. The 
confirmation page appears.

Step 10 Web browser: When the License Registration Confirmation page appears, check that the information is 
correct, then click Get Approval Code. The approval code appears.

Step 11 License Manager: Click Next and enter the approval code that appears in the web browser. 

Note This code can be very long, so make sure you copy the entire approval code. 

Step 12 License Manager: After you enter the approval code, click Next.

Step 13 License Manager: If the Select Product Modules license window appears, click OK. Then click File > 
Exit to close the License Manager.

Step 14 To start using the program, exit the License Manager and start the program.

Deregistering a License (Express Method)
The following procedure is the quickest and easiest way to deregister a license. This method requires 
that your computer be able to communicate directly with the Cisco Solutions license-registration server 
over the Internet, either directly or using a proxy server.

Note The Express method can fail due to firewall restrictions, socket or proxy errors, or transaction time-outs. 
If you cannot deregister the license using this method, try the Browser method (as described in the 
“Deregistering a License (Browser Method)” section on page 5-7).

Deregistering a Component License (Express Method)

Step 1 Start the License Manager: Go to the Windows Start menu and choose Start > Programs > 
Cisco Network Planning Solution 1.0 > License Manager. 

Step 2 In the License Manager, expand the license file by clicking on the + sign next to the License file folder 
icon. Make sure the license you want to deregister is available (green).

Step 3 Select the license you want to deregister by clicking on it. To select one license, click on it. To select 
multiple licenses, control-click or drag on the licenses. 
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Note If a license that is represented by a “white page” icon, then that license is currently in use. If you 
want to deregister a license that is currently in use, you must shut down the application that is 
using that license.

Step 4 Click Deregister License on the right side of the License Manager window.

Step 5 When prompted to select the transaction method, click Express. This method is easiest and fastest.

Step 6 When the Authentication window appears, enter your Username, Password, and Group ID in the 
appropriate fields.

Step 7  If the computer uses a proxy server, click Specify Proxy; when the Specify proxy server information 
window appears, fill in the requested information and click OK. 

Step 8 Click OK in the Authentication window. 

• A progress window might appear while the license is deregistered from your computer. 

• A window should then appear to indicate that the operation succeeded.

Deregistering a License (Browser Method)
Before using the Browser method, try the Express method. With the Express method, there is no need to 
exchange codes and you can add many licenses to your computer in one operation. Use this procedure 
if the Express method fails or you prefer to use the Browser method.

Note If you still cannot deregister your licenses using this method, see the “Technical Support for Licensing 
Operations” section on page 5-8.

Deregistering a Component License (Browser Method)

Step 1 Start the License Manager: Go to the Windows Start menu and choose Start > Programs > 
Cisco Network Planning Solution 1.0 > License Manager. 

Step 2 License Manager: Expand the appropriate license file by clicking on the + sign next to the License file 
folder icon. Make sure the license you want to deregister is available (green).

Step 3 License Manager: Select the license you want to deregister by clicking on it. To select one license, click 
on it. To select multiple licenses, control-click or drag on the licenses. 

Note If a license that is represented by a “white page” icon, then that license is currently in use. If you 
want to deregister a license that is currently in use, you must shut down the application that using 
that license.

Step 4 License Manager: Click Deregister License.

Step 5 License Manager: When prompted, click on the Browser button.

Step 6 The License Manager launches your Web browser and points it to the OPNET Quick Support Page for 
Cisco Solutions. If your browser fails to launch, start it manually and navigate to the following URL: 

http://www.opnet.com/support/cisco_qsp.html
5-7
Installation Guide for Cisco Network Planning Solution

78-17023-01



Chapter 5      Adding and Upgrading Licenses
    Technical Support for Licensing Operations
Then follow the License Registration link in the browser window.

Step 7 Web browser: Log in with your Cisco Solution username and password. Then click on License 
Registration.

Step 8 Web browser: Follow the Perform license operations link, then select Deregister License 
(delete_permits) and click Next.

Back in the License Manager, a dialog box containing a Transaction Code and Hostname field should 
appear.

Step 9 Web browser: Copy the Transaction Code and Hostname from the License Manager into the browser 
window, then click Next. You can either paste the text or type it manually. 

Note Make sure there are no extra spaces before or after the text you enter.

Step 10 Web browser: When the Select the starting license number page appears, select the lowest license ID 
that you want to deregister from your computer. If you want to deregister only one license, select that 
license.

Step 11 Web browser: When the Select the ending license number page appears, select the highest license ID that 
you want to deregister from your computer. If you want to deregister only one license, select that license.

Step 12 Web browser: When the License Registration Confirmation page appears, check that the information is 
correct, then click Get Approval Code. The approval code appears.

Step 13 License Manager: Click Next and enter the approval code that appears in the browser. 

Note This code can be very long, so make sure you copy the entire approval code. 

Step 14 License Manager: Click Next. The confirmation code appears. 

Step 15 Web browser: Enter the confirmation code that appears in the License Manager, then click Next. 

The confirmation code is saved in the Session Log, which is available from the Help menu in the Cisco 
Solution software.

Step 16 License Manager: click Done. The license is deregistered and you can now add it to another computer. 

Technical Support for Licensing Operations
If you cannot manage your licenses using the Express or Browser methods, or if you have additional 
questions or problems regarding your licenses, you can do the following:

• Go to the OPNET Quick Support Page for Cisco Solutions 
(http://www.opnet.com/support/cisco_qsp.html)

• Contact Cisco Systems as described in the “Obtaining Technical Assistance” section on page xi
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Uninstalling Cisco Network Planning Solution

These installation instructions apply to the programs included in Cisco NPS release 1.0.

Uninstalling Design and Analysis (Windows)
Normally, "Add/Remove Programs" will uninstall Design and Analysis. The following procedure 
describes how to manually uninstall Design and Analysis from Windows (in case "Add/Remove 
Programs" does not work for any reason).

Uninstalling Design and Analysis from Windows (Standard)

This is the recommended procedure for uninstalling Design and Analysis from Windows.

Step 1 If this machine has licenses installed on it, de-register them. For more information, see “Deregistering a 
License (Express Method)” section on page 5-6 or “Deregistering a License (Browser Method)” section 
on page 5-7.

Step 2 Open the Windows Control Panel from the Start menu at the bottom left of the Windows screen:

Start > Settings > Control Panel

Step 3 In the Windows Control Panel, double-click Add/Remove Programs.

Step 4 Scroll down the list of installed programs, select the Cisco Network Planning Solution 1.0 entry, and 
click Remove.

If you cannot uninstall Design and Analysis by using the Add/Remove Programs control panel, and you 
want to ensure that all of the Design and Analysis files have been removed, perform the “Uninstalling 
Design and Analysis from Windows (Advanced)” procedure on page 6-1. 

Uninstalling Design and Analysis from Windows (Advanced)

You should do this procedure ONLY if you could not uninstall Design and Analysis using the 
“Uninstalling Design and Analysis from Windows (Advanced)” procedure on page 6-1.

Step 1 If this machine has licenses installed on it, de-register them. For detailed instructions, see the 
“Deregistering a License (Express Method)” section on page 5-6 and the “Deregistering a License 
(Browser Method)” section on page 5-7.
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Then, try uninstalling Design and Analysis in the normal fashion by using the Add/Remove Programs 
feature: choose Start > Settings > Control Panel > Add/Remove Programs.

If you cannot uninstall Design and Analysis by using the Add/Remove Programs control panel you can 
also follow these manual steps to ensure all of the Design and Analysis files have been removed and no 
trace of Design and Analysis is left on your system.

Step 2 Remove all files under the installation directory. By default this is:

C:\Program Files\Cisco\CiscoNPS1.0

Step 3 If you had licenses installed on this machine, delete the C:\OPNET_license directory. Be sure you have 
already de-registered the licenses (as described in Step 1) before deleting the directory.

Step 4 There are shortcuts under the Start > Programs > Cisco Network Planning Solution 1.0 menu. You can 
remove these using the Advanced Taskbar properties.

a. Right-click on the Windows task bar.

b. Select Properties. The Taskbar Properties dialog box appears.

c. Choose the Advanced tab.

d. Click the Advanced button under Customize Start Menu. Windows Explorer opens.

e. Go up the tree to All Users > Start Menu, then delete the directories relating to Cisco NPS software.

Step 5 Remove Registry entries.

Warning Be very careful when you edit the system registry. Any incorrect changes to the registry can cause 
your Windows system to become unstable.

a. Start regedit.

b. Open the registry tree to: \\HKEY_LOCAL_MACHINE\SOFTWARE\

c. Remove the following registry key:

OPNET Technologies\Cisco Network Planning Solution 1.0\OPNET\11.0.A

Step 6 Design and Analysis creates two directories in your user's home directory (op_admin, op_models).

These directories can be deleted if you no longer wish to keep your custom models and projects.

Step 7 Lastly, remove the InstallShield bookkeeping files.

a. Make sure that you can view hidden system files on your PC. This procedure varies on different 
versions of Windows so ask your system administrator if you do not know how to perform this 
procedure.

b. Open the following directory:

C:\Program Files\InstallShield Installation Information\

c. CTRL-F to find files and look for the following:

Files named: *.ini

Containing text: OPNET

This will show some directories with long names consisting of numbers and letters surrounded by 
{}.

d. You will now need to manually match the directories in which these files were found and remove 
them from the InstallShield Installation directory. The Find Files feature in Windows does not let 
you delete the directories in which the files were found.
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Without these directories being deleted along with the Design and Analysis software future 
installations of Design and Analysis may fail.

Warning DO NOT delete the entire InstallShield Installation Information directory, because other software you 
have installed may have information installed here. Be sure only to delete those directories relating 
to Cisco NPS software.

You have now removed Design and Analysis entirely from your system.

Uninstalling Virtual Network Data Server
Normally, you just need to perform the following procedure. However, this does not remove all 
components. If this is a problem for you, see the “Removing the Virtual Network Data Server Installation 
(Complete Uninstall)” section on page 6-5.

Uninstalling Virtual Network Data Server (Standard)

Step 1 If this machine has licenses installed on it, de-register them. For more information, see the 
“Deregistering a License (Express Method)” procedure on page 5-6 or “Deregistering a License 
(Browser Method)” procedure on page 5-7.

Step 2 Open the Windows Control Panel from the Start menu at the bottom left of the Windows screen:

Start > Settings > Control Panel

Step 3 In the Windows Control Panel, double-click Add/Remove Programs.

Step 4 Scroll down the list of installed programs, select the Cisco NPS 1.0 Virtual Network Data Server entry, 
and click Remove.

If you cannot uninstall Virtual Network Data Server by using the Add/Remove Programs control panel, 
and you want to ensure that all of the Virtual Network Data Server files have been removed, perform the 
“Removing All Virtual Network Data Server Elements” procedure on page 6-5. 

Step 5 Delete the install directory. The default install directory is:

C:\Cisco\CiscoNPS1.0\VNEServer\3.0.1_<build_number>.

Uninstalling Virtual Network Data Server (Advanced)
Normally, you just need to perform the “Removing Virtual Network Data Server Database Contents” 
procedure on page 6-4. However, this does not remove all components. To remove all components from 
your system, work through the rest of this section.

The following items remain:

• A portion of the install directory

• The top-level Program Group shortcut for the release
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• The top-level Windows Registry entry for the release might also remain

• In addition, database contents and archive and temp directories remain

Any services installed by the release should be completely removed from the system by the uninstaller.

To perform the following procedures, log into the Virtual Network Data Server host using an account 
with administrator and ORA_DBA privileges.

Removing Virtual Network Data Server Database Contents (Optional)
If you want to completely remove the tablespace files and user account for Virtual Network Data Server 
from a local database, perform the following steps. You will only want to perform this procedure if you 
are permanently removing Virtual Network Data Server from a system AND want to remove database 
contents as well as the product installation.

Note If you perform this procedure, do it before you remove the Virtual Network Data Server installation.

Removing Virtual Network Data Server Database Contents 

Step 1 Stop services and exit the Control Panel.

Step 2 Open a command window and use the cd command to set the working directory to the Virtual Network 
Data Server installation directory. The default install directory is:

C:\Cisco\CiscoNPS1.0\VNEServer\3.0.1_<build_number>.

Step 3 Type: sqlplus system/<password>

A Connected to: Oracle banner message appears if you succeed in logging into Oracle.

Step 4 To get a list of database instance names, type: select name from v$database;

A list (probably just one item) of database names known to Oracle appears. If more than one name 
appears, work with your DBA to identify which one is used for Virtual Network Data Server.

Step 5 While still in sqlplus, type: @drop_accounts.sql <dbname>

where the <dbname> is the one identified in the previous step.

• Progress messages appear as the user account and tablespace files are deleted.

• When done, the database instance still exists, but the tables and account used by Virtual Network 
Data Server no longer exist.

Note ALL network project data written to the database by Virtual Network Data Server is deleted by 
this procedure.
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Removing the Virtual Network Data Server Installation (Complete Uninstall)
Perform this procedure ONLY if you need to completely remove everything installed or generated by 
Virtual Network Data Server.

Removing All Virtual Network Data Server Elements

Step 1 Stop services and exit the Control Panel.

Step 2 If you are running a local License Server that was installed with Virtual Network Data Server, use the 
Windows Service manager to stop the License Server.

Step 3 Use Windows Task Manager to stop any running processes owned by Virtual Network Data Server such 
as javaw, java, op_monitor, or op_license_server.

Step 4 Run the uninstaller for the release you wish to remove.

Continue with the following steps to remove remnants of the installation.

Step 5 Delete the install directory. The default install directory is:

C:\Cisco\CiscoNPS1.0\VNEServer\3.0.1_<build_number>

Step 6 Delete the Java Jre directory (if it remains). This directory is located under the parent install directory.

Note If you have other Virtual Network Data Server releases that you want to keep and they are 
installed to the same parent directory, skip this step. Otherwise, you'll remove the Jre used by a 
release you want to keep.

Step 7 Delete the top-level Program Group shortcut for the release. All users have a shortcut.

Delete the shortcut from:

C:\Documents and Settings\All Users\Start Menu\Programs

Step 8 Start regedit: From the Windows Start menu, choose Run; then enter regedit and click OK.

Warning Be very careful when you edit the system registry. Any incorrect changes to the registry can cause 
your Windows system to become unstable.

Step 9 In the Windows Registry Editor, find and select the following entry:

<release>HKEY_LOCAL_MACHINE\SOFTWARE\OPNET 
Technologies\Cisco Network Planning Solution 1.0\OPNET VNE Server 3.0.1

Where <release> is 3.0.1.

Step 10 Right-click on the entry and select Delete from the menu to delete the entry.

Step 11 Verify that any services installed by Virtual Network Data Server are gone. Remove the following 
services if they still exist in the Registry at the following location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

- OPNET_License_Server

- OPNETVNESxxx

Where xxx is AdapterServer, BootstrapService etc.

Step 12 Verify that the uninstaller entry in the Registry has been removed. Remove the entry if it still exists

in the Registry at the following location:
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HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

The entry name is:

Cisco NPS 1.0 Virtual Network Data Server

Step 13 Exit the Windows Registry Editor.

At this point, Virtual Network Data Server is completely removed from your system. 
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Oracle Installation and Setup Procedures

This appendix includes a series of procedures for installing Oracle software for use with Virtual Network 
Data Server. For information about when to perform each procedure, see the “Installation Workflow” 
section on page 4-1.

Note Oracle 9i database and Oracle 9i Application Server (AS) TopLink are required for Virtual Network Data 
Server, but these products are not part of the Cisco Solutions bundle. The instructions in this appendix 
are included for the convenience of Cisco NPS users. For detailed information about using Oracle 
products, consult the Oracle product documentation or Oracle technical support.

Installing the Oracle 9i Database 

Note Use caution when installing Oracle for use with Virtual Network Data Server. Recovery is difficult if 
Oracle is incorrectly installed. 

You can install the Oracle database on the same host PC as Virtual Network Data Server or on a different 
host. Install the database on the appropriate host. 

Installing the Oracle 9i Database

Step 1 Log into the host PC as Administrator or as a user with full administrative privileges. If you are not 
logged in with the proper privileges, log off and then log on with an appropriate account.

Step 2 Insert the Oracle installation CD into the CD-ROM drive of the host PC for the database. If the installer 
does not start automatically, use Start > Run to execute Oracle’s setup.exe program. 

The installer displays a Welcome panel. 

Step 3 Click Next to proceed to the File Locations panel. 

The installer prompts you for an installation path in the File Locations panel. Oracle (9.2.0.1.0) requires 
about 2.8 GB of disk space. 

Step 4 Enter an installation path that resides on a disk with adequate free space. Click Next to proceed. 

The installer prompts you for the Oracle product to install in the Available Products panel. 

Step 5 Select the Oracle 9i Database product. Click Next to proceed. 

The installer prompts you for the type of installation in the Installation Types panel. 
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Step 6 Select a Personal, Standard, or Enterprise edition installation. Any of these editions can be used with 
Virtual Network Data Server. The Enterprise edition is recommended for best scalability and 
performance. 

Step 7 Click Next to proceed. 

The installer prompts you for the type of database in the Database Configuration panel. 

Step 8 Select General Purpose. Click Next to proceed. 

The installer prompts you for the port number for the Oracle MTS Recovery Service. 

Step 9 Leave the default port number (2030) unchanged. Click Next to proceed. 

The installer prompts you for a global database name (GDN) in the Database Identification panel. 
Virtual Network Data Server will work with any valid GDN and SID that Oracle accepts. 

Answer with a GDN constructed according to the following rules:

• Global Database Name = o92a<name>.<domain>.com

• Example: o92avnes.opnet.com 

Note If the first portion of the GDN exceeds 8 characters, the Oracle installer will block installation. 

The installer prompts you for a system ID (SID). Some examples follow:

• o92a 

• o92avnes

• vnesDB

Note The GDN is used by Oracle to create the TNS Service Name; Virtual Network Data Service uses 
this name to connect to the database. The TNS Service Name is an alias for the GDN and is used 
throughout the remainder of this installation guide to refer to the database. 

Step 10 Enter the SID you wish to use. After entering a GDN and SID, click Next to continue to the Database 
File Location panel. 

The installer prompts you for the Database File Location. 

Step 11 Keep the default location and click Next to proceed. 

The installer prompts you for the Database Character Set. 

Note To view the list of supported Oracle database and national character sets for use with Virtual 
Network Data Server, refer to Virtual Network Data Server: System Requirements, page 2-4. 

Step 12 Choose a supported character set and click Next to proceed with file installation. 

The Oracle installer takes up to 30 minutes to copy files to the installation directories. Oracle 9i has three 
installation CDs. The installer prompts you to insert a new CD in the CD-ROM drive when it is ready to 
copy files from the next CD. 

During this time, Install, Configuration Tools, and Database Creation panels appear. 

Step 13 Click Next or OK to proceed through these panels. 

Note A window titled HTTP Server may open at this point. You can close this window.
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An installation Summary panel appears. 

Step 14 Click Install to proceed. 

The Database Configuration Assistant prompts you for new passwords for the SYS and SYSTEM 
accounts. 

Step 15 Enter the passwords that you wish to use for these accounts and click OK when done. 

Step 16 When installation is complete, an End of Installation panel appears. Click Exit to close the Oracle 
installer.

Note You do not need to create a user account for Virtual Network Data Server at this time. The 
account is established after Virtual Network Data Server installation. 

e. Record the Oracle GDN, SID, install path and database hostname in Table A-1 on page A-6

f. View installation logs when installation is complete. Installation logs are located here:

C:\Program Files\Oracle\Inventory\logs\installActions.log 

If you run the Oracle installer again, the install actions log is renamed with an embedded 
date-stamped name such as: installActions2002-01-24_xxx. 

Note About Oracle Services: After Oracle installation, several Windows services are created. 
Virtual Network Data Server only requires the Oracle services listed below. These Windows 
services should be configured to automatically start when the PC is booted. All other Oracle 
services may be configured for manual start/stop unless specifically needed for other uses. 
The following services are required for Virtual Network Data Server to run: 
OracleOraHome92TNSListener and OracleService<DB SID>. 

Oracle 9i (9.2.0.1.0) installation is now complete. 

After Virtual Network Data Server is installed, one final configuration step is required to finish Oracle 
setup for Virtual Network Data Server. This step is described in the “Configuring the Oracle Database” 
section on page A-7, but is not performed until after installation of Virtual Network Data Server. 

Proceed to the next step of the installation workflow (as described in the “Installation Workflow” section 
on page 4-1).

Installing the Oracle 9i Client 
The Oracle client is always installed on the same host PC as Virtual Network Data Server. The Oracle 
client is required by Virtual Network Data Server to communicate with an Oracle database located on 
another host PC.

Note If you have already installed the Oracle 9i database on this host, do not install the Oracle 9i client.

Warning Use caution when installing Oracle for use with Virtual Network Data Server. Recovery is difficult if 
Oracle is incorrectly installed. 
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Installing the Oracle 9i Client

Step 1 Log into the host PC as Administrator or as a user with full administrative privileges. If you are not 
logged in with the proper privileges, log off and then log on with an appropriate account.

Step 2 Insert the Oracle installation CD into the CD-ROM drive of the host PC for Virtual Network Data Server. 
If the installer does not start automatically, use Start > Run to execute Oracle’s setup.exe program. 

The installer displays a Welcome panel. 

Step 3 Click Next to proceed to the File Locations panel. 

The installer prompts you for an installation path in the File Locations panel. Oracle Client (9.2.0.1.0) 
requires about 200 MB of disk space. 

Step 4 Enter an installation path that resides on a disk with adequate free space. Click Next to proceed. 

The installer prompts you for the Oracle product to install. 

Step 5 Select the Oracle 9i Client product. Click Next to proceed. 

The installer prompts you for the type of installation in the Installation Types panel.

Step 6 Select Runtime. Click Next to proceed to the Summary panel. 

An installation Summary panel appears. 

Step 7 Click Install at this panel to begin Oracle installation. The Oracle installer takes up to 30 minutes to 
copy files to the installation directories. 

Note The final installation tasks involve setting up Net services using the Net Configuration Assistant. 

Step 8 Click Next at the Configuration Tools panel. 

The installer prompts you for whether you want to use a directory service at the Net Configuration 
Assistant panel. 

Step 9 Select No and click Next. 

The installer prompts you for the version of Oracle used by the database at the Database Version panel. 

Step 10 Select Oracle 8i or later database and click Next. 

The installer prompts you for a database service name at the Service Name panel. 

Step 11 Enter the Global Database Name used during Oracle database installation on the database host PC. This 
name should be the same as the Database TNS Service Name collected in Table A-1 on page A-6. Click 
Next. 

The installer prompts you for the communication protocol to use at the Select Protocols panel.

Step 12 Select the appropriate protocol to use (such as TCP) and click Next. 

The installer prompts you for the database host name. 

Step 13 Enter the hostname as an IP address or a fully qualified domain name and click Next. 

The installer prompts you for whether you want to test the database connection. 

Step 14 Answer Yes and click Next. 

The installer displays the test status in a test result panel. 

Step 15 Click Next. 
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Note Investigate and resolve any problems if the connection test fails. 

The installer prompts you for whether or not you want to configure another service name. 

Step 16 Answer No and click Next. 

A Configuration Complete panel appears. 

Step 17 Click Next. 

Another completion panel appears. 

Step 18 Click Finish. 

The installer displays an End of Installation panel. 

Step 19 Click Exit to close the Oracle installer.

Installation logs are located here: 

C:\Program Files\Oracle\Inventory\logs\installActions.log 

If you run the Oracle installer again, the install actions log is renamed with an embedded date-stamped 
name such as: installActions2002-01-24_xxx. 

After Virtual Network Data Server is installed, one final configuration step is required to finish Oracle 
setup for Virtual Network Data Server. This step is described in the “Configuring the Oracle Database” 
section on page A-7, but is not performed until after installation of Virtual Network Data Server. 

Proceed to the next step of the installation workflow (as described in the “Installation Workflow” section 
on page 4-1).

Collecting Oracle Database Access Information 
The Virtual Network Data Server installer prompts for database access information. Before beginning 
installation, collect the database access information listed in the following table. The database 
administrator can supply the database access information that you need. Print the installation 
instructions and write down the database access information in Table A-1 on page A-6; then you can 
reference this information during installation. Proceed with the “Installing Virtual Network Data Server” 
section on page 4-3. 

The Database Account User Name in the following table is the account used by Virtual Network Data 
Server to access network data stored in the database. This account is created after Virtual Network Data 
Server is installed using the user name and password entered during Virtual Network Data Server 
installation. 

Note DO NOT use SYS or SYSTEM for the Database Account User Name. Select an account name that is 
dedicated for use by Virtual Network Data Server. 
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Installing Oracle TopLink
The Virtual Network Data Server requires access to an installation of Oracle 9i Application Server 
Toplink which is patched to release 9.0.3.5. This section describes how to install Toplink 9.0.3.5 on your 
system. Install Toplink on the same system as Virtual Network Data Server. 

Note You must perform the following procedure before you install Virtual Network Data Server. 

Installing Toplink 9.0.3.5

Step 1 Download or copy the required Oracle Toplink components into a working directory: 

• Oracle Toplink 9.0.3.0 (A99417-01.zip) 

• Oracle Toplink 9.0.3.5 patch (p3188702_9031_GENERIC.zip)

Step 2 Create a working directory on your system. Copy the downloaded Oracle Toplink 9.0.3.0 and 9.0.3.5 zip 
files to this directory.

Step 3 Unzip the Oracle Toplink 9.0.3.0 archive, A99417-01.zip, into the working directory. 

Step 4 Execute the Toplink 9.0.3.0 installer, toplink903-windows.exe:

a. At the introduction panel, click Next. The installer prompts you for the installation folder. 

Table A-1 Database Access Information Worksheet

Access Item Value Description

Database TNS Service name 
(alias for Database GDN) 

The TNS Net Service name used for the local or 
remote database. Refer to the “Locating a Database 
Net Service Name in tnsnames.ora” section on 
page A-11 in the Appendix for instructions on 
locating the service name.

Database SID The database system ID. Required for remote 
databases only

Database hostname The IP address or fully qualified domain name for 
the database host. Required for remote databases 
only 

Oracle Home (installation) directory The Oracle installation directory on the database 
host. Required for remote databases only

Oracle Oradata Parent directory The parent directory to the Oracle oradata 
directory on the database host. Required for remote 
databases only

Database account user name User name of the account used to access the 
database. DO NOT use the Oracle SYS or SYSTEM 
accounts. 

Database account password Password for the account used to access the 
database. 
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Note If you already have an Oracle installation on this system, the default Toplink installation folder 
will be in your Oracle installation. Cisco recommends that you use this folder. Write down the 
installation folder you choose; you will need it later during installation of Virtual Network Data 
Server. 

b. Select an install folder and click Next. In the remaining panels, the installer prompts you for:

– Shortcut Location      (select your preference)

– Toplink Features       (select Full Install) 

– Viewing Release Notes (select your preference) 

c. Work through the remaining installer panels and enter the preferences in Step b. Click Done in the 
Install of TopLink Complete panel to exit the installer. 

Step 5 Do the following steps to install the Toplink 9.0.3.5 patch. 

a. Open a window to the working directory that contains the Toplink patch, 
p3188702_9031_GENERIC.zip. 

b. Unzip the Oracle Toplink patch archive, p3188702_9031_GENERIC.zip, into the Toplink 
installation directory. For example, if you installed Toplink to C:\oracle\ora92\toplink, select this 
path as the extraction path for the archive. 

c. If you are prompted to confirm file overwrite, select "Yes to All".

d. Close the archive application (WinZip or similar application) when done. 

e. Verify that the Toplink installation has the files required by Virtual Network Data Server. The 
following files should exist in the <toplink install>\core\lib directory: 

– tl_core.jar

– tl_tools.jar

– tl_x.jar 

At this point, Toplink 9.0.3.5 is installed on your system and ready for access during Virtual Network 
Data Server installation. Proceed to the next step of the installation workflow (as described in the 
“Installation Workflow” section on page 4-1.)

Configuring the Oracle Database 
After Virtual Network Data Server is installed, the Oracle database must be configured for use by Virtual 
Network Data Server. This involves running a SQL script that creates tablespaces for the database and a 
Virtual Network Data Server access account. This SQL script is run on the host system for the Oracle 
database.

For information about your database, see Table A-1 on page A-6.

Configuring the Oracle Database

Step 1 If the Oracle database and Virtual Network Data Server are located on the same host system, open a 
command window and navigate to the Virtual Network Data Server installation directory by typing the 
following:
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cd <install path>\VNEServer\3.0.1_X 

For example, you might enter: cd C:\Cisco\CiscoNPS1.0\VNEServer\3.0.1_880

Stay in the command window on the host system for Virtual Network Data Server and continue with 
Step 2. 

If the Oracle database is not on the same host system as Virtual Network Data Server, type

sqlplus system/<system password>@<DB TNS Service Name> 

For example, if the Database TNS Service Name is o92avnes and the account password is magic, type: 
sqlplus system/magic@o92avnes 

Stay in the command window on the database host and continue with Step 2. 

Step 2 Type sqlplus system/<system password> in the command window. 

Step 3 At the sqlplus prompt, type @setup_accounts.sql

A message banner appears that states how much free disk space is required on the disk that hosts the 
database. 

Note If you do not have sufficient disk space available to run this script, free sufficient disk space 
before proceeding. If you wish to cancel the script, press Ctrl-C or close the command window. 

Step 4 Click Enter to continue. 

A message banner appears with a list of database parameters, parameter settings, and whether the 
parameters meet recommended settings. 

Note If all parameters meet recommended settings, no further action is required. If one or more 
parameters do not meet recommended settings, running the dbparamchg.sql script after this 
procedure is recommended. Running the script will improve data import performance with large 
networks and increase Oracle memory requirements. For more information, see the “Modifying 
Database Parameters” procedure on page A-9.

Step 5 Click Enter to continue. 

Step 6 Note the correct database instance name for use in the next step. 

The setup_accounts script prompts you for the database instance name. 

Step 7 Enter the database instance name obtained in Step 6.

Note If more than one database name appeared when you ran the previous step, check with your 
Database Administrator to determine the correct database.

Note If the database is located on a Solaris system, the case (uppercase, lowercase) of the characters 
in the database instance name must match the case of the name of the database directory. This 
directory is located under the oradata directory on the Solaris database host.

The setup_accounts script prompts you for the user password. 

Step 8 Enter the same database user account password that was entered during Virtual Network Data Server 
installation and written down in Table A-1 on page A-6.
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A message informs you that the Virtual Network Data Server user account and all data will be deleted 
by this script. 

Step 9 Click Enter to continue. 

Note When you run this script for the first time, several SQL error messages appear. You can ignore 
these messages. The messages are the result of the script trying to remove Virtual Network Data 
Server table and user accounts that do not exist prior to this script being run for the first time. 

This SQL script configures database storage for use by Virtual Network Data Server and sets up the user 
account. After the script finishes, the Oracle account information for Virtual Network Data Server is the 
user name and password from Table A-1 on page A-6.

Step 10 Type quit to exit sqlplus. 

A log of script actions is saved to <install_dir>\setup_accounts.<timestamp>.log. 

A log of database analysis results is saved to <install_dir>\analyzedb.<timestamp>.log.

If the setup_accounts script recommended changing your database settings during Step 4, and you 
agree with the recommended changes, perform the “Modifying Database Parameters” procedure on 
page A-9 now. 

If you do not need to change your database settings or choose not to change them, perform the “Verifying 
the Oracle Configuration” procedure on page A-10; this procedure helps you verify that Oracle is 
configured correctly for use with Virtual Network Data Server. 

Modifying Database Parameters 
This optional procedure is performed on the database host system. The database parameter changes 
produced by this script improve product performance when working with large networks and will 
increase Oracle memory requirements. 

Note This procedure only applies to Oracle 9i users. Work with your Database Administrator to run this script. 

Modifying Database Parameters

Step 1 Type sqlplus system/<system_password> in a command window on the database host system. 

Note If the Oracle database is not on the same host system as Virtual Network Data Server, connect 
to the remote database using the methods described in Step 1 of the “Configuring the Oracle 
Database” procedure on page A-7. 

Step 2 At the sqlplus prompt, type @dbparamchg.sql 

A message shows the path to the Oracle spfile that contains the parameters for your database. 

Step 3 Make a backup copy of the spfile at the path specified in the previous step. 

Step 4 Click Enter as many times as needed to step through information messages produced by this script. 
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When the script finishes, a list of the changed parameters and their new settings appears with a reminder 
to restart the Oracle DB service for the changes to take effect. 

Step 5 Type Quit to exit sqlplus. 

Step 6 Use the Windows Service Manager to stop and restart the Oracle database service. 

a. From the desktop, select Start > Settings > Control Panel > Administrative Tools > Services to 
open the Windows Service Manager. 

b. Select the service named OracleService<DB SID>.

c. Right-click on the service and select Stop from the menu. 

d. After the Service Control progress dialog completes, right-click on the service and select Start from 
the menu to restart the service. 

Step 7 If the Oracle database service fails to restart, restore the original spfile for the database and repeat Step 6 
to recover. 

Perform the“Verifying the Oracle Configuration” procedure on page A-10 to verify that you can connect 
to the database through the Virtual Network Data Server account. 

Verifying the Oracle Configuration 
Perform this procedure on the database host to verify that you can connect to the database through the 
Virtual Network Data Server account. 

Verifying the Oracle Configuration

Step 1 Type sqlplus <user name>/<password> in a command window on the database host system. Use the 
user name and password from Table A-1 on page A-6. 

Warning Do not use SYS or SYSTEM as the user name. 

Note If the Oracle database is not on the same host system as Virtual Network Data Server, use the 
same methods described in Step 1 of “Configuring the Oracle Database” procedure on page A-7 
to connect to the remote database. 

a. If Oracle configuration is successful, an Oracle banner and a Connected To: message appears. 

Type quit at the SQL> prompt to exit. 

b. If Oracle configuration fails, error messages inform you that login has been denied.

Reconfigure the Oracle database and verify again. If configuration problems persist, contact Cisco 
Technical Support. 

Virtual Network Data Server installation and database configuration are now complete. Proceed to the 
next section to verify the Virtual Network Data Server installation. 
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Locating a Database Net Service Name in tnsnames.ora 
Virtual Network Data Server uses a database’s Oracle Net service name for connection to the database. 
This is true whether Virtual Network Data Server uses a local or remote database. The database service 
name is located in the tnsnames.ora file. This file is located in  <oracle install 
dir>\ora92\network\Admin for Oracle 9i. A sample file is shown in the following section. 

In the following sample file (see the “TNSNAMES.ORA Example File” section on page A-11), there are 
three entries. The O92AML14.Cisco.COM entry represents the database service name. Each entry has a 
<net service name> = () structure. The text string preceding the “=” is the service name. In this example, 
you use O92AML14.Cisco.COM as the service name for Virtual Network Data Server installation. 

Note that this file has entries for other Oracle Net services and may contain entries for more than one 
database. If the Oracle installation you are using supports other products, contact the database 
administrator for the service name you should use. 

TNSNAMES.ORA Example File
# TNSNAMES.ORA Network Configuration File: Example
# C:\programs\oracle\ora92\network\admin\tnsnames.ora
# Generated by Oracle configuration tools.

O92AML14.CISCO.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = o92aml14)
    )
  )

EXTPROC_CONNECTION_DATA.CISCO.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC0))
    )
    (CONNECT_DATA =
      (SID = PLSExtProc)
      (PRESENTATION = RO)
    )
  )

INST1_HTTP.CISCO.COM =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = mlpc14)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVER = SHARED)
      (SERVICE_NAME = o92aml14)
      (PRESENTATION = http://admin)
    )
  )
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